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This chapter describes how to increase the information available, or simply update the existing
information, in the following Srructural and Support tables:

o Seisnmogenic Sources of all types (section 4.1.);

o Previous Fault Compilations (section 4.2.);

o Additional Geophysical/Seismological Data (section 4.3.);
o Tectonic Lineaments (section 4.4.).

This chapter will allow any user to enter new seismogenic sources, modify existing ones, add new
background information to them, and modify the content of the Inregrated Source Dataser (§ 2.2.3.7.).
It will also allow new or revised Previous Fault Compilations, new layers of relevant geophysical or
seismological data, new or revised Tectonic Lineaments to be easily entered in the Database as soon
as they become available (e.g.. [ollowing a new publication or the release of a new elaboration through
the Internet).

The chapter does not describe how to update the information contained in most of the Source
Generic Support Tables (§ 2.2.5.2.) and in all of the Generic Suppoit Tables (§ 2.2.5.3.). The reasons
for this decision are: 1) that the structure of this information, and hence of the associated tables,
is rather complex, and 2) that the information contained in them is rather basic and is not likely to
change significantly over the next few years. This condition applies to all seismological data, both
historical and instrumental (§ 2.2.5.2.1.,2.2.5.2.2), to the individual intensity data associated with the
historical earthquakes, and to all Geographic and Elevation Data (§ 2.2.5.3.1.) and Administrative
Data (§ 2.2.5.3.2.).

To update the Database the user will have to:

» use standard text editors and drawing programs to prepare the new or updated material;

e use the standard commands of the computer operating system to place the new or updated tables/
files in the appropriate location (§ 2.2.1.);

 use the standard commands and functions of MapInfo to add new rows of data to the existing
tables;

= use the standard commands and functions of Maplnfo™ to turn raster images into Maplnfo' tables,
and to georeference them if needed (for example, if the image is to become one of the Previous Fault
Compilationsy;

» use the Database itself to perform the Mainienance (see section 4.5.), a routine that prepares and
displays new graphic objects corresponding to the newly added information and updates the
necessary software links.

Notice that the level of knowledge of MapInfo” and of its tools that is required to update the
Database information varies greatly depending on the type of operation that should be performed. For
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example, updating a texL file requires very limited understanding of Maplnfo”, of the structure of the
Database and of the operating system of the computer used for the update operation. In contrast,
adding new images or new Surface Ruptures 1o an existing source, adding a new source or adding a
new Previous Fault Compilation requires substantial skills, not only to reach satisfactory results but
also to avoid corrupting the Darabase.

4.1. ADDING INDIVIDUAL SOURCES

This scction describes how to add a new seismogenic source to the Database, or to update/modify
an existing one. At the end of the procedure described in this section the user must run the
Maintenance (see section 4.5.) to allow the Daiabase to create new graphic objects corresponding to
the new/updated source. A new source corresponds (o a new row of the relevant table and to a new
graphic object automatically generated and associated with this new row of data during the Mainte-
nance. Notice that no change in the graphical appearance of the Darabase will be visible befors the
Mainrenance is correctly performed.

4.1.1. Entering source parameters

This section assumes that the user already knows all the parameters needed to represent the
particular source type within the Database. For the sake of simplicity all our descriptions refer to the
case of a new Geologic/Geophysical source being added to the Database. Therefore all the variables
mentioned in the following section belong to the table SourceGeol.tab and must be entered
directly in this table using standard Maplnfo” procedures {e.g., adding a new row of data, filling in
the relevant variables, saving the updated table, etc.). Please refer to the scheme shown in § 2.2.3.1.
for further details. Sources of different types require a subset of the operations described here,
depending on the given source-type structure (§ 2.2.3.).

For a source of the Geologic/Geophysical category with associated surface ruptures the essential
information includes:

* geometric and kinematic parameters;

¢ length, width, minimum and maximum depth from the surface of the rectangle that represents the
projection of the source onto the surface;

* coordinates of the rectangle that represents the projection of the source onto the surface:

* coordinates of the northern and southern tips of the intersection between the projection of the fault
plane and the surface (for E-W faults the two sets of coordinates are interchangeable). Notice that
this condition applies not only to blind faults proper, but also to surface-breaking faults following
the assumption that the minimum depth of faulting can never be less than | km (this circumstance
is tfurther discussed in § 2.2.3.1.);

* map location and references of any associated surface ruptures.

The user is encouraged to take advantage of the Microsoft” Excel code FaultMapper 3.2 (Basili,
2000) for:

* obtaining the full set of coordinates for a source of known geometry and size but for which the
location is known only with reference to a single point (for example, only the location of a corer
is known);

¢ testing the impact of different fault parameters, both geometric and spatial.

FaultMapper is available to all users on the same physical medium used to distribute the

Database. It can also be downloaded from the Internet site of the Istituto Nazionale di Geofisica ¢

Vulcanologia (http:/fwww.ingv.it/).
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4.1.1.1. Assigning a new identification code

Any new source requires the assignment of an individual, unequivocal SourceName and
IDSource for table SourceGeol.tab, SourceHistA.tab, etc. (see detailed characteristics
of these variables in § 2.2.3.). SourceName should identify concisely the geographic location of the
source and should not generate ambiguities with respect to nearby sources. The code IDSource
must be assigned following the conventions described in § 2.2.3.1. through 2.2.3.6. (e.g., in the range
1-200 for sources of the Geologic/Geophysical category), provided that the code has not been already
assigned to an existing source.

4.1.1.2. Entering spatial and geometric parameters

The four pairs of latitude and longitude coordinates of the rectangle representing the surface
projection of the source and the two pairs of coordinates of its intersection with the topographic
surface must be entered as latn, lonn (where n varies between | and 4) and as 1atN, lonN,
lats. 1cns, respectively. Latitudes and longitudes must be expressed in degrees (up to three digits)
and thousandths of degree (three digits), separated by a point (e.g., “43.9767, *7.289"”). The default
for all coordinates is “N latitude™ and “E longitude”. Notice that all these coordinates must be
analytically consistent with all the other source parameters.

Length and Width describe the source size in terms of distance between the farthest edges and
of down-dip width and must be expressed in kilometers. The product length x width returns the
total source area (which is larger than the area of the surface projection of the same source}.

Strike, Dip and Rake are standard angles describing the geometry and kinematics of the
source. Notice that for sources derived from historical data the field Strike may optionally contain
also the uncertainty on its determination.

Min_depthand Max_depth describe the minimum and maximum depth of the plane represent-
ing the source from the topographic surface, in kilometers.

Notice that all variables described must contain valid, non-null values. Failure to enter any of the
parameters will cause malfunctions during the subsequent Maintenance procedure or ambiguities in
the use of the Database. In any case, the graphic representation of each source is governed entirely
by the assigned geographic coordinates. The user is hence responsible for checking carefully their
correctness and consistency before entering new data.

4.1.1.3. Entering descriptive parameters

Descriptive parameters form the non-analytical part of the information supplied with each source
and are optional although recommended for preserving the integrity of the source schematisation
proposed in the Database.

Quality describes the reliability of the source data and is expressed by one or two parameters.
The criteria adopted for rating all source types in the first release of the Daiabase are discussed in
§ 2.2.3.1. and 2.2.3.2.

Evidence describes in plain words the type of evidence used to identily and characterise the
given source. The user is invited to refer to the definitions already used for existing sources (0 preserve
homogeneity.

Compi led_by gives credit o the compiler(s) of all the information gathered (or the given source
and of all resulting estimates. Please remember that this implies that the compiler(s) share(s) with the
editors of the Database full scientific responsibility for the given source.
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Finally, the field Preferred isused during the Maintenance to decide whether the new source
should or should not be included in the Integrated Source Dataset (§ 2.2.3.7.). Leaving this field
empty defaults to “F” (False), which meuns that the source will not be included in the Integrated
Source Dataset.

4.1.1.4. Entering surface ruptures

The user may want to represent in the cartographic interface one or more surface ruptures
(§ 2.2.3.9.) that are thought to slip in conjunction with one or more sources of the Geologic/
Geophysical category. Notice that the procedure described below requires mastering most ol the
fundamental functions of Maplnfo” and is net recommended to inexperienced users.

To enter new surface ruptures you must first run the Database and locate the surface ruptures using
the Digital Elevation Model, the drainage data, information contained in the Additional Geophysical/
Seismological Data, or a raster image prepared and georeferenced expressly for this purpose (e.g.,
the scanned version of a field map, a figure from a paper, a figure from the Database itself, etc.). You
must then:

1} close the Database and go back to the standard Maplnfo' tools;

2) click on the Layer Control button and turn the Cosmetic Laver to “editable’™

3) open the table FaultScarps.tab;

4) draw a single uninterrupted surface rupture using the Polyline tool;

5) use the menu sequence Map > Save Cosmetic Objects to transfer the newly drawn surface rupture
to FaultScarps.tab;

6) if you have more than one surface rupture to draw, or if the surface rupture must be represented
by two separate fragments, go to (3) and cycle the steps (4) through (3) until needed (however,
it is strongly recommended that you work on a limited number of fragments at a time);

7) click on one of the existing surface ruptures, select the “Style™ button and take note of the
standard style and colour used by the Database to represent them. The standard style is a
continuous line with barbs marking the downthrown side of the rupture;

8) apply the same style and colour to the new surface ruptures. In doing so please notice that the
style selected will cause the barbs to be on one side or on the other:

9) browse the table FaultScarps.tab and complete the information needed to identity each
single strand of surface rupture:

* the IDSource of the source that is thought to be connected with the given surface rupture;

* aprogressive IDScarp, valid only for the subset of surface ruptures connected to a single source:

= the name of the relevant source (optional);

¢ the name of the given fragment of surface rupture, possibly followin g the common usage found
in the scientific literature concerning the given region (optional):

¢ the reference of the paper where the given fragment was first described/established. The refer-
ence must appear among the references associated with the relevant source. Leaving this field
blank indicates that the surface rupture was established by the compiler(s) of the relevant
source.

10) Save FaultScarps.tab (this will overwrite the existing table; you must create a backup
copy of it befarehand if you want to retain the original information) and run the Mainrenance
procedure,

Notice again that this procedure generates graphic objects unequivocally identified by their logic
(but supposedly also physical!) link with an existing source. The Database stores the geographic
location of all surface ruptures in its own internal format. The coordinates of a given fragment can
hence be retrieved only using the Maplnfo” standard tools.
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4.1.2. Adding explanatory texts for individual sources

This section describes:
« how to prepare the textual information that accompanies each source and how to name the text files
correctly;
o where to put the new files and filenames.

4.1.2.1. Text content
In addition to the quantitative parameters, cach source is described by two text files:

1) A Summaries of the Main Studies on the Source file that summarises in chronological order the

papers that describe the source and its tectonic environment. This may include:

—

» early papers on the field reconnaissance of the source:

= papers that present the results of seismological or geodetic analyses of the last major carthquake
generated by the source:

= papers describing paleoseismological or geomorphological investigations;

« papers presenting regional models that deal explicitly or implicitly with the specific source.

Notice that the source parameters will be partly derived trom papers referenced in the Summary.

Also notice that the Summary is merely a synthetic description of published refevant work on the

given source. As such, it should be as complete as possible but should not contain any comment

or criticism by the compiler on any of the referenced papers.

2) A Conmments and Open Questions file that separately summarises into two distinct sections the
compiler’s comments on the present level of knowledge of the given source (Cominents) and on
what still needs to be investigated or understood (Open Questions).

The Comments section should:

= justify the rating of the source:

= acknowledge any existing competing models;

e highlight any contradictions among papers and state which model/paper was preferred and why;

» for any of the source parameters, explain from which paper, original observations or reasoning
it was derived.

The Open Questions section should summarise the questions still open about the identification
and characterisation of the source, pointing out investigations that have never been done,
observations that should be made and considerations on the relationships between the given
source and the adjoining ones, with possible suggestions concerning future research efforts. An
optional section termed “Links to other seismogenic sources” may be freely be added to the
Comments and Open Questions file to highlight the relationships among neighbouring sources in
better detail.

The Swmmaries of the Main Studies on the Source and Comments and Open Questions files [or non
Geologic/Geophysical sources (i.e., all intensity-based sources) normally includes only a reference to
the historical seismicity catalogue from which the given source was derived. The only exceptions are
represented by the sources of the two categorics Historical - Well Constrained with Geological
Background and Historical — Poorly Constrained with Geological Background (§ 2.2.3.2. and
2.2.3.4.), for which a full literature background is supplied.
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4.1.2.2, Text format and other conventions

The two files contuining the Swmmaries of the Main Studies on the Source and Comments and
Open Questions should be written as plain text files with line breaks using Word or any simple tex(
cditor and according to the following format specifications:

* single line spacing;

¢ references written as: ... this was suggested by Black (1997), .... (Black, 1997), .... (Black and
White, 1998), .... (Black et al., 1999);

* text width set at 17 cm maximum (corresponding to the width of the relevant dialog box).

No specific font or style (e.g.. italic) can be used because plain text files do not retain the font
information. Use the font that is most convenient for preparing the texts and then let the editor choose
its pre-set one when the file is saved.

4.1.2.3. Naming and placing the text files in the Database

All the names of the text files have the same structure. Use the following examples to understand
how to name [iles:
* S-ITA007.txt (for the “Swmmaries of the Main Studies on the Source” file)
* Q-ITA007.txt (for the “Comments and Open Questions” file)
where “S™ and “Q” indicate that the file contains a “Summaries of the Main Studies on the Source”
or “Comments and Open Questions™ text for the given source, “ITA” stands for the country the source
is in (Italy, in this case), “0077 is the conventional three-digit 1D of the given source.

The S-ITAx.txt file must be placed in the Previous_Studies subfolder of the
Source_Literature folder, while the @-ITA« . txt file must be placed in the Open_Questions
subfolder of the Source_Literature folder.

4.1.2.4, Updating the assign studies and assign questions tables

Finally, the names of the new files must be manually entered as new rows of the Assign
Studies.tab (for the S-ITA« file) and Assign Questions.tab (for the Q-ITA« file). For
both tables the information to be entered is the following:

* IDSource > conventional ID of the source to which the text is assigned:;
* FileName > name of the file that contains the text.

Notice that these tables do not need to be sorted after appending new rows and that no Maintenance

is required after having entered new text files,

4.1.3. Adding pictures and captions for individual sources

This section describes:
* How to select pictures to be associated with a given source:
* How to prepare the pictures and their captions;
= How lo choose the picture titles;
* How to create Maplnfo~ tables to display pictures;
* How to name picture files correctly:
* Where to put the picture and caption files;
* How to update the relevant lnstrumental Table (Assign Pictures.tab).
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Notice that entering new pictures in a new release of the Database to be published requires
permission by the copyright holder, il the picture is covered by copyright. Specific permission was
abtained for all of the pictures contained in the first version of the Database that were shown to be
covered by copyright.

4.1.3.1. Selecting pictures

The choice of the pictures to be associated with any given source is entirely up to the compiler.
Suitable pictures include scanned ligures or photographs from published papers, original (ie..
unpublished) raster images prepared by the compiler, original (i.e., unpublished) photographs taken
by the compiler or for which informal permission has been granted by the author. A picture may also
be created by assembling pictures and photographs from different sources. The main requirement is
that the picture be representative of one or more of the main features of the source, including its
location or field appearance, trench logs, elaborations of source parameters, earthquake recurrence
properties, etc. The size and quality of the original must be sufficient to grant readability even after
scanning and compression. To improve the readability of pictures taken from journals or books it is
often advisable to retain their original caption (in addition to the Darabase caption). This may involve:
1) scanning a larger area to include the original caption, or 2) mounting the original caption over the
figure using empty space. In either case one should verify that even the finest print of the caption is
fully readable after the picture has been entered in the Database.

Some publishers require that their copyright be explicitly marked on the image to be reproduced
(e.g., © 1998 American Geophysical Union). In the Database this procedure was always followed
when explicitly requested by the publishers, but also in the case of journals that do not enforce a strict
copyright policy.

4,1.3.2. Preparing a new picture

To generate appropriale picture files you need a graphic software to manipulate the raster
(“bitmap™) images to be entered in the Database, and MaplInfo' to create the new tables associated
with the pictures.

Composing the picture

Scanned images should be first saved in any of the common graphic formats (.7if format recom-
mended) with a resolution in the range 200-400 dpi depending on the size of the picture, on the size
of the smallest characters or symbols in it, and on its general appearance. Since MaplInfo displays
only raster images, any original images available in vectorial format must be first converted into raster.

The saved graphic file must then be opened to create additional blank space for the caption, either
at the bottom of the figure or on its right-hand side. The amount of space varies depending on the size
of the caption, but is normally in the order of about 2 ¢cm for horizontal captions below the picture and
5-6 cm for vertical captions next to the picture. The space should be enough to contain 254 characters
written in Helvetica 14. The extended image must then be saved as a .jpg file with a compression
factor in the range 70-100%. depending on the size of the figure and on the complexity of its
information content. If no additional space is prepared MapInfo™ will place the caption over the
image. This is generally undesirable, but in some instances it could be done on purpose (e.g., when
the image is big but the graphic information in it is not very dense).
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Naming the picture file

All the names of picture files have the same structure. Use the following example to understand
how to name files:

Fl_Pezza_scarp.jpg

A picture file name is composed of:

e a capital letter “F” for “figure”;

¢ the conventional identification number of the source to which the picture refers, followed by the
underscore (*_7);

e the picture name, with words separated by the underscore (*_);

* the extension associated with the graphic format of the picture file.

The picture name can be composed using the name of the author(s), the year of publication, a
significant characteristic of the picture, or any combination of all these elements (for example:
Pantosti_etal_1993, Subsurl’_geology, Montello_section). The maximum number of characters for a
picture file name is 31, of which 4 are reserved for the suffix “_CAP” used for the caption
corresponding to each picture and 4 for the suffix “.tab”. Special characters like “ (dot) and /"
(slash) are not allowed by Maplnfo”.

Preparing a MapInfo' table with a picture

Once your picture is properly formatted and named, you can turn it into a Maplnfo™ table ready
to be entered in the Database. To do this please follow these steps:

* run MapInfo and go to the menu File > Open Table: un Open Table dialog box will appear:

* select Raster fmage in the Format pop-up window that appears at the bottom of the dialog box:

= open the picture to be entered in the Database;

* when prompted by the system, select Display. This will make the picture appear centred on the
window and will create a MapInfo' table with the same name of the original picture except for the
extension (.tab instead of jpg, .il, etc.). The new table will be placed in the same folder as the
original picture. This is also the time to verify the presence of the blank space previously allocated
for the caption;

* close the new table by clicking Close Al from the menu File.

The Tast step of this procedure is to open the relevant folder and verify that the file has been
correctly placed and named. For a picture called

Fl_Pezza_scarp.jpg
MaplInfo~ will have created a table called
Fl_Pezza_scarp.tab

If the picture file name has the correct MapInfo™ icon but does not contain the extension “.tab™ (this
may depend on the computer you are using), you must add it manually to match the conventional file
name established through the Assign Pictures.tab (§ 4.1.3.5.).

4.1.3.3. Creating captions

Captions are created using a text editor or using MaplInfo” directly. The caption must describe very
briefly the content of the picture, or the portions of the picture that are relevant to the specific seismic
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source, and must give appropriate credit to its author(s). The caption must be succinet also because

MaplInfo allows a maximum of 254 characters to be displayed all at once. Use the text editor to count

the characters of your caption, or proceed by trial-and-error. The reference to the author(s) must be

made in one of the following ways: ...(from Black and White [2000]), ...(from Black et al. [1999]),

{from Black et al. [1999], modified), ...(photo courtesy of John Smith). If no credit is given it is

assumed that the ligure was entirely prepared, or the photographs taken, by the compiler.

When the caption is ready in your text editor make a copy of it in the clipboard and then:

run Maplnfo';

o open the Maplnfo  table to which the caption refers and maximise it (full screen);

e click on the Laver Control button and turn the Cosmetic Layer to “editable™;

e click on the Text button of the Maplnfo™ Drawing or Standard buttonpads (marked by an “A”) and
place the cursor where you want o start writing the caption (below the image or next to it
depending on how the additional blank space was laid out);

= type a single character to create the graphic object that will contain the caption, then edit it by
double-clicking it with the pointer tool from the buttonpad. This will open a Text Object dialog box.
Place the cursor in the empty box indicated by “text” and paste the text stored in the clipboard:

o sel the Line Spacing at 1.5 and the Srvle to Helvetica;

o scl the Font Size to 16-18 pt, depending on the space available for the caption. Notice that the font
size is a function of the screen size. This description assumes that you are using a 1024 x768 pixel
screen; smaller screens will require a proportionally smaller font;

= close the dialog box by pressing OK and look at the outcome of the operation. If the caption does
not fit under the figure you must re-edit it and introduce line breaks in-between words to force the
alignment. This procedure is normally cycled 2 or 3 times until the appearance of the caption is
sutisfactory.

The caption is now ready and stored in the Cosmetic Layer. To save in a disk file go to Map menu
and activate the command Save Cosmetic Objects. Press SAVE in the dialog box that will appear and
enter the name of the caption file in the appropriate space. This name must be formed combining the
full name of the picture with the suffix *_CAP”, followed by “.tab”. For example. the picture

Fl_Pezza_scarp.jpg
will be contained in a MapInfo  table named
Fl Pezza scarp.tab
and will have its caption in a Maplnfo~ table named
Fl Pezza scarp CAP.tab

To conclude the operation, close the new table by clicking Close Afl from the menu File. Then open
the relevant folder and verify that the file has been correctly placed and named. By now Maplnfo
should have created and placed in the same lolder four different files:

¥l Pezza_ scarp CAP.tab
Fl_Pezza scarp_ CAP.MAP
Fl Pezza_ scarp CAP.ID

Fl Pezza scarp_ CAP.DAT

In case of mistake, the caption file names can be changed only from inside MapInfo  (menu Table >
Maintenance > Rename table). Please keep in mind that changing Maplnfo” file names manually
ruins them permanently.
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4.1.3.4. Giving a title to a picture

Each picture is identified by a title that appears in the Pictures dialog box (from the menu Source
Info >). The title has a maximum length of 50 characters and must be informative without redundancy.
The same title cannot be assigned to more than one picture because the Darabase uses the titles as an
identifier to retrieve the picture files. Notice that the title of the picture and the name of the picture
file have quite different scopes. While the former informs the user on the content of the picture, the
latter is mainly used by the system.

4.1.3.5. Updating the table assign pictures

The last step of this procedure is to enter the information concerning the new pictures into the table
Assign_Pictures.tab. This is done manually by creating new rows and entering the picture
information;

e IDSource > conventional ID of the source to which the picture is assigned;
e Title > title of the picture;

e Picture > name of the picture file;

* Caption > name of the caption file.

Notice that these tables do not need to be sorted after appending new rows and that no Maintenance
is required after having entered new pictures,

4.1.3.6. Placing the picture and caption files in the Database

Any new picture concerning an existing source must be placed in the F« sub-subfolder of the
Pictures subfolder of the S8ource TLiterature folder. If the source has not been already
established. the user must create a new empty folder named Fx, where = is the IDSource to be
assigned to the new source (§ 4.1.1.1.). Six new files must appear in the selected folder at the end of
this procedure: two for the picture itself and four for the caption. For the usual picture called
Fl_Pezza_scarp.ipg, we will {ind:

Fl_Pezza_scarp.ipg
Fl_Pezza_ scarp.tab

Fl Pezza scarp CAP.tab
Fl_Pezza_scarp_CAP.MAP
Fl Pezza scarp CAP.ID
¥l Pezza_scarp CAP.DAT

4.1.4. Adding references for individual sources

New references for existing or new sources or lineaments can be manually entered in the Database
as new rows of the Assign_References.tab. Sce § 2.2.4.4. for the structure of this table and
see existing references for details about the format (for example, the convention adopted to list the
authors of a given article, map, book or manuscript).

In consideration of the large number of references that may be handled by the Database, it is
strongly recommended that the Assign References. tab table is not updated directly but rather
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through a twin-file prepared with Microsoft Excel, Microsoft” Word or any editor that may exchange
files with Muaplnfo . Notice that any new reference must be uniquely identified with the
Code_ReferencelID, which is the code assigned to the given article, map, book or manuscript
within the physical database of printed papers available at Istituto Nazionale di Geofisica e Vulca-
nologia in Rome. Resorting to a Microsoft” Excel copy of the references table allows an easier check
of the existing codes and a safer assignment of a new one. At any rate, Assign_References.tab
does not need to be sorted after entering new relerences and no Maintenance is required at the end
of this procedure.

4.2, ADDING PREVIOUS FAULT COMPILATIONS

New or updated Previous Fault Compilations can be easily entered in the Darabase as soon as they
become available. The procedure for entering a new Previous Fault Compilation involves adding a
new row o the Compilations. tab table and filling-in the various fields comprising the table. See
§ 2.2.5.2.3. for the structure of this table and see existing references for details about the format (for
example, the convention adopted to list the authors of the given Previous Fault Compilation).

The preparation of the actual graphic file containing the Previous fFault Compilation to be entered
in the Database follows a procedure that is largely similar to that already described for the preparation
of new pictures (§ 4.1.3.2.). Also in this case you must first gencrate appropriate picture files using
a graphic software to manipulate the raster (“bitmap”) images to be entered in the Database, and
Maplnfo  to create the new tables associated with the pictures. The main difference here is that the
Previous Fault Compilations must also be accurately georeferenced using standard MapInfo proce-
dures. Please see sub-section “Composing the picture” in § 4.1.3.2. for all details concerning the
image resolution and flormat.

There is no specific scheme form naming a new Previous Fault Compilation. The user may follow
the general rules already discussed in the section on Preparing a new Picture - Naming the Picture
File (§ 4.1.3.2.), except that no prefix is nceded such as the “F«” used to identify all pictures related
to the = source. Nevertheless it is recommended that the title begins with a geographic reference such
that the compilations will appear listed in some geographically ordered fashion (refer to the existing
table for further details).

4.3. ADDING ADDITIONAL GEOPHYSICAL/SEISMOLOGICAL DATA

New or updated layers of Additional Geoplysical/Seismological Data can always be added to the
Database at the user’s convenience. Similarly (o the case of the Previous Fauli Compilations, the
procedure for entering one of these layers involves adding a new row to the Additional_Data.tab
table and filling-in the various fields comprising the table. Sce § 2.2.5.2.4. for the structure of this
table and see existing references for details about the format (for example, the convention adopted to
list the authors of the given layer of Additional Geophysical/Seismological Data).

The preparation of the file containing the new layer of Additional Geophysical/Seismological Data
to be entered in the Darabase varies depending on whether the information is supplied as a vector file
or as a raster image.

For vector-type information no special preparation is required, and the user is entirely in charge
of deciding the stvle of representation (symbol type, symbol size, line thickness, colours, etc.) that
best suits the Darabase. In deciding a style of representation, however, the user will have in mind the
graphical contrast needed for representing the newly entered information over the existing Database
tables such as Digital Elevation Model.
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For raster information the procedure is similar to that already described for the preparation ot
Previous Fault Compilations (see section 4.2.).

The name ol a new table of Additional Geophysical/Seismological Data is not governed by any
convention such as the “F+" used to identify all pictures related to the +source. The name will simply
describe at its best the content of the table or its authors.

A new veclor-type table of Additional Geophysical/Seismological Data can be accompanied by as
much information as it is available to the user. Once it is open. a table of this category follows the
standard rules of Maplnfo . In particular, the information associated with the graphic ebjects can be
retrieved through the Object Info ool from within the Darabase. More standard MaplInfo ™ tools (e.g..
statistics, find/query, etc.) become available when the Database is closed and control is fully returned
1o MapInfo®,

4.4. ADDING TECTONIC LINEAMENTS

The procedure for updating the Tectonic Lineaments is very similar to that already described for
updating the surface ruptures (§ 4.1.1.4.). To enter a new Tecionic Lineament you must first run the
Daitabase and locate it using the Digital Elevation Model, the drainage data, information contained
in the Additional Geophysical/Seismological Data, or a raster image prepared and georeferenced
expressly for this purpose (¢.g.. the scanned version ol a satellite image, a figure from a paper, a figure
from the Database itself, etc.). You must then:

1} close the Database and go back to the standard Maplnfo” tools;
2) click on the Layer Control button and turn the Cosmetic Laver to “editable™;
3) open the table Tectonic_Lineaments.tab;
4) draw a single uninterrupted lineament using the Line or Palyline tool;
5) use the menu sequence Table > Append Rows to Tuble to append the newly drawn Tectonic
Lineament to the existing ones;
0) click on one of the existing lineaments and take note of the standard style and colour used by the
Database to represent them;
7) apply the same style and colour to the new lincament;
9) browse the table Tectonic_Lineaments.tab and complete the information needed to
identify each single lineament:
* the Name of the lineament as it was established by the literature;
= a progressive 1D that identifies it unequivocally. In assigning the ID the user should make sure
to pick a code has not been already assigned to an existing lineament;
= the name of the relevant source (optional);
¢ the type ol lineament, whether Transverse (“T") or Generic (“G™);
* the Reliability of the lineament, expressed with an adjective (e.g.. poor, very good, etc.:
max. 16 characters);
¢ the Evidence of the lineament, expressed with a description (the user is invited to refer to
the definitions already used for existing lineaments to preserve homogeneity; max. 80 charac-
ters);
* the Notes, a field that describes facts and open questions concerning the given lineament
(max. 250 characters);

10) Save the table Tectonic_Lineaments.tab (this will overwrite the existing table; you must
create a backup copy of it beforehand if you want to retain the original information) and run the
Maintenance procedure.

Notice that a Tectonic Lineament can be associated with specific references following the same
procedure as that seen for seismogenic sources of all types (§ 2.2.4.4. and 4.1.4.).
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4.5. DATABASE MAINTENANCE

Once all the material concerning a new or updated source or lineament has been created and
entered in the Database, you must run the menu Maintenance > Updating Sources o allow the
Database to create new links and graphic objects corresponding with the current information. Wait
for a completion message (“Update Sources OK™) and then check the results of your work. During
this process the Database:

e creates the boxes, circles and hexagons associated with the different types of sources;

e links the surface ruptures to the sources;

» creates the Integrated Source Dataset (§ 2.2.3.7.) by merging all the sources that exhibit a “T” in
the Logical field Preferred of all the tables containing seismogenic sources.
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